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¢ No part of this manual may be reproduced in any form.
e All specifications and designs are subject to change without notice.

The products in this manual are controlled based on Japan's "Foreign Exchange and
Foreign Trade Law". The export from Japan may be subject to an export license by the
government of Japan.

Further, re-export to another country may be subject to the license of the government of
the country from where the product is re-exported. Furthermore, the product may also be
controlled by re-export regulations of the United States government.

Should you wish to export or re-export these products, please contact FANUC for advice.

In this manual we have tried as much as possible to describe all the various matters.
However, we cannot describe all the matters which must not be done, or which cannot be
done, because there are so many possibilities.

Therefore, matters which are not especially described as possible in this manual should be
regarded as "impossible".

This manual contains the program names or device names of other companies, some of
which are registered trademarks of respective owners. However, these names are not
followed by ® or ™ in the main body.
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SAFETY PRECAUTIONS

This "SAFETY PRECAUTIONS" section describes the precautions
which must be observed to ensure safety when using machines
equipped with the Program Transfer Tool and a FANUC CNC. Users
are requested to read "SAFETY PRECAUTIONS" carefully before
using functions described in this manual. Users should also read the
relevant descriptions in the Operator's Manual to become fully familiar
with the functions to be used.

Contents
DEFINITION OF WARNING, CAUTION, AND NOTE ................ s-2
GENERAL WARNINGS AND CAUTIONS......cocoovieieeeeeeeeeeeeeen. s-3
WARNINGS AND NOTES RELATING TO THE PROGRAM
TRANSFER TOOL ... s-5
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DEFINITION OF WARNING, CAUTION, AND NOTE

This manual includes safety precautions for protecting the user and
preventing damage to the machine. Precautions are classified into
Warnings and Cautions according to their bearing on safety. Also,
supplementary information is described as Notes. Read the Warnings,
Cautions, and Notes thoroughly before attempting to use the
machine.

/\ WARNING
Applied when there is a danger of the user being
injured or when there is a danger of both the user
being injured and the equipment being damaged if
the approved procedure is not observed.

/\ CAUTION
Applied when there is a danger of the equipment
being damaged, if the approved procedure is not
observed.

NOTE
Notes is used to indicate supplementary information
other than Warnings and Cautions.

- Read this manual carefully, and store it in a safe place.
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SAFETY PRECAUTIONS

GENERAL WARNINGS AND CAUTIONS

/\ WARNING

1 Before operating the machine, thoroughly check the

entered data. Operating the machine with incorrectly
specified data may result in the machine behaving
unexpectedly, possibly causing damage to the
workpiece and/or machine itself, or injury to the user.
Never attempt to machine a workpiece without first
checking the programmed value, compensation
value, current position, and external signal settings.
Also, never attempt to machine a workpiece without
first checking the operation of the machine. Before
starting a production run, ensure that the machine is
operating correctly by performing a trial run using, for
example, the single block, feedrate override, or
machine lock function, or by operating the machine
with neither a tool nor workpiece mounted. Failure to
confirm the correct operation of the machine may
result in the machine behaving unexpectedly, possibly
causing damage to the workpiece and/or machine
itself, or injury to the user.

Ensure that the specified feedrate is appropriate for
the intended operation. Generally, for each machine,
there is a maximum allowable feedrate. The
appropriate feedrate varies with the intended
operation. Refer to the manual provided with the
machine to determine the maximum allowable
feedrate. If a machine is run at other than the correct
speed, it may behave unexpectedly, possibly causing
damage to the workpiece and/or machine itself, or
injury to the user.

When using a tool compensation function, thoroughly
check the direction and amount of compensation.
Operating the machine with incorrectly specified data
may result in the machine behaving unexpectedly,
possibly causing damage to the workpiece and/or
machine itself, or injury to the user.

The parameters for the CNC and PMC are factory-set.
Usually, there is no need to change them. When,
however, there is no alternative other than to change
a parameter, ensure that you fully Failure to set a
parameter correctly may result in the machine
behaving unexpectedly, possibly causing damage to
the workpiece and/or machine itself, or injury to the
user.
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/\ CAUTION

1

Immediately after switching on the power, do not
touch any of the keys on the MDI panel until the
position display or alarm screen appears on the CNC
unit.

Some of the keys on the MDI panel are dedicated to

maintenance or other special operations. Pressing

any of these keys may place the CNC unit in other
than its normal state. Starting the machine in this
state may cause it to behave unexpectedly.

The operator's manual for Program Transfer Tool

describes all the basic functions of the CNC,

including the optional functions. The selected
optional functions vary with the machine. Some
functions described in this manual may not,
therefore, be supported by your machine. Check the
machine specifications before using Program

Transfer Tool.

Some machine operations and screen functions are

implemented by the machine tool builder. For an

explanation of their usage and related notes, refer to
the manual provided by the machine tool builder.

For example:

- On some machines, executing a tool function
causes the tool change unit to operate. When
executing a tool function on such a machine,
stand well clear of the tool change unit.
Otherwise, there is a danger of injury to the
operator.

- Many auxiliary functions trigger physical
operations, such as rotation of the spindle. Before
attempting to use an auxiliary function, therefore,
ensure that you are fully aware of the operation to
be triggered by that function.

NOTE

Command programs, parameters, and variables are
stored in nonvolatile memory in the CNC. Generally,
the contents of memory are not lost by a power on/off
operation. However, the contents of memory may be
erased by mistake, or important data in nonvolatile
memory may have to be erased upon recovering
from a failure.

To enable the restoration of data as soon as possible
if such a situation arises, always make a backup of
the data in advance.
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WARNINGS AND NOTES RELATING TO THE PROGRAM TRANSFER
TOOL

Warnings and notes relating to the Program Transfer Tool are described
below and also in the chapters in this manual. Before using the Program
Transfer Tool, read this manual thoroughly and be familiar with the
contents of the warnings, cautions, and notes.

/N WARNING

1 When using a program on an actual CNC machine,
ensure that the machine and tool controlled by the
program instructions operate safely before starting
to operate the machine.

If an incorrect program is used for a reason, or if a
program is used incorrectly, the machine or tool may
operate unpredictably, possibly causing damage to
the tool, machine, or workpiece, or a danger of the
user being seriously injured.

2 This software transfers programs to a CNC
machine, but the software does not check whether
these programs operate on the CNC machine
properly. When using a program on an actual CNC
machine, therefore, observe the instructions
described in warning 1 above.

3 When even a program that has run normally on an
actual CNC machine is used repeatedly, the
contents of the program input to the CNC machine
may change because of degradation of the storage
medium of the program or change in communication
environment if the program is transferred by a
communication function. Therefore, when using a
program on the actual CNC machine, observe the
instructions described in warning 1 above.

In this manual, programs for giving CNC machines
instructions to operate are referred to as programs.
In manuals of CNC machines, these programs are
sometimes called machining programs, part
programs, or programs. When these terms have the
same meanings and purposes as the term
"program" used in this manual, be sure to observe
the warnings described above.
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Exclusive control for files

NOTE
Be careful not to attempt to perform more than one
operation such as downloading, uploading, editing,
copying, movement, and deletion for one program
at the same time.

Downloading to the program memory and Series 30i/ 317 /32i DATA SERVER

NOTE
O numbers and file names stored in the program
memory or DATA SERVER are not file names on
the personal computer but are O numbers and file
names written in files.
It is recommended that the write protection
parameter of the CNC be set to prevent
unpredictable overwriting.

Downloading of data other than programs

NOTE
When tool offsets, custom macros, and workpiece
origin offsets are downloaded, values in the CNC
are changed.
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OUTLINE OF THIS MANUAL

Organization

This manual applies to the Program Transfer Tool edition 3.0.
This chapter provides an outline of this manual.

This manual is outlined below.

SAFETY PRECAUTIONS
This part describes notes that the user needs to bear in mind
when reading this manual.

I. GENERAL
This part outlines this manual.

I1. INSTALLATION
This part describes how to install the Program Transfer Tool.
Be sure to read this part before installing the tool.

II1. SETTING
This part describes the settings to be made for using the
individual functions.

IV. OPERATION
This part describes how to operate each screen.

APPENDIX
This part describes the settings to be made for the CNC or
Windows OS.
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Related manuals

The table below lists manuals related to this manual.

When using this manual, refer to the manuals listed below as well.

Related manuals of Ethernet board

Manual name Specification
number
gisésrfén;ts/ '\F/;\Sl:llj)z’lt:’:l Server For Series 30i-A B.64014EN
OPERATORS MANUAL. B-63644EN
OPERATORS MANGAL B-63354EN

Related manuals of FANUC Series 30i/3001, 31i/310

1, 32i/320i -A

Manual name

Specification

number
DESCRIPTIONS B-63942EN
CONNECTION MANUAL (HARDWARE) B-63943EN
CONNECTION MANUAL (FUNCTION) B-63943EN-1
USER'S MANUAL
(Common to Lathe System/Machining Center System) B-63944EN
USER'S MANUAL (For Lathe System) B-63944EN-1
USER'S MANUAL (For Machining Center System) B-63944EN-2
MAINTENANCE MANUAL B-63945EN
PARAMETER MANUAL B-63950EN

Related manuals of FANUC Series 16i/1601, 18i/180

i,21i/210i -A

Manual name

Specification

number
DESCRIPTIONS B-63002EN
CONNECTION MANUAL (HARDWARE) B-63003EN
CONNECTION MANUAL (FUNCTION) B-63003EN-1
Series 161/18i/160i/180i/160is/180is —TA B-63004EN
OPERATOR’S MANUAL
Series 16i/18i/160i/180i/160is/180is —MA B-63014EN
OPERATOR’S MANUAL
Series 21i/210i/210is —TA OPERATOR’S MANUAL B-63084EN
Series 21i/210i/210is -MA OPERATOR’S MANUAL B-63094EN
MAINTENANCE MANUAL B-63005EN
Series 16i/18i/160i/180i/160is/180is —A B-63010EN
PARAMETER MANUAL
Series 21i/210i/210is —A PARAMETER MANUAL B-63090EN
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Related manuals of FANUC Series 16i/160i, 18i/180i, 21i/210i -B

Manual name

Specification

number
DESCRIPTIONS B-63522EN
CONNECTION MANUAL (HARDWARE) B-63523EN
CONNECTION MANUAL (FUNCTION) B-63523EN-1
Series 16i/18i/160i/180i —TB OPERATOR’'S MANUAL B-63524EN
Series 16i/160i/160is—MB, Series 18i/180i/180is —-MB5, |B-63534EN
Series 18i/180i/180is -MB OPERATOR’S MANUAL
Series 21i/210i -TB OPERATOR’S MANUAL B-63604EN
Series 21i/210i -MB OPERATOR’S MANUAL B-63614EN
MAINTENANCE MANUAL B-63525EN
Series 16i/18i/160i/180i/160is/180is —B B-63530EN
PARAMETER MANUAL
Series 21i/210i -B PARAMETER MANUAL B-63610EN

Related manuals of FANUC Series 0i -B

Manual name

Specification

number
DESCRIPTIONS B-63832EN
CONNECTION MANUAL (HARDWARE) B-63833EN
CONNECTION MANUAL (FUNCTION) B-63833EN-1
Series 0i—TB OPERATOR’'S MANUAL B-63834EN
Series 0i—-MB OPERATOR’S MANUAL B-63844EN
MAINTENANCE MANUAL B-63835EN
PARAMETER MANUAL B-63840EN

Related manuals of FANUC Series 0i -C

Manual name

Specification

number
DESCRIPTIONS B-64112EN
CONNECTION MANUAL (HARDWARE) B-64113EN
CONNECTION MANUAL (FUNCTION) B-64113EN-1
Series 0i—-TC OPERATOR’'S MANUAL B-64114EN
Series 0i—MC OPERATOR’S MANUAL B-64124EN
Series 0i—-TTC OPERATOR’S MANUAL B-64284EN
MAINTENANCE MANUAL B-64115EN
PARAMETER MANUAL B-64120EN

Related manuals of FANUC Series 0i -D

Manual name

Specification

number
DESCRIPTIONS B-64302EN
CONNECTION MANUAL (HARDWARE) B-64303EN
CONNECTION MANUAL (FUNCTION) B-64303EN-1
USER'S MANUAL B-64304EN
(Common to Lathe System/Machining Center System)
USER'S MANUAL (For Lathe System) B-64304EN-1
USER'S MANUAL (For Machining Center System) B-64304EN-2
START-UP MANUAL B-64304EN-3
MAINTENANCE MANUAL B-64305EN
PARAMETER MANUAL B-64310EN
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Related manuals of FANUC Series 20i -B

Manual name

Specification

number
DESCRIPTIONS B-63522EN
CONNECTION MANUAL (HARDWARE) B-64193EN
CONNECTION MANUAL (FUNCTION) B-63523EN-1
OPERATOR'S MANUAL B-64204EN
MAINTENANCE MANUAL B-64195EN
PARAMETER MANUAL B-64200EN

Related manuals of FANUC Power Mate i -D/H

Manual name

Specification

number
DESCRIPTIONS B-63172EN
CONNECTION MANUAL (HARDWARE) B-63173EN
CONNECTION MANUAL (FUNCTION) B-63173EN-1
OPERATOR'S MANUAL B-63174EN
MAINTENANCE MANUAL B-63175EN
PARAMETER MANUAL B-63180EN
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License agreement

The terms and conditions set forth by FANUC must be agreed upon
by a costumer who purchases the Program Transfer Tool.

These terms and conditions represent the license agreement between
the customer and FANUC LTD. (referred to as FANUC) related to
the software product (referred to as the software) purchased by the
customer.

Article 1 Licensing of right for use

FANUC grants the customer the following right related to the

software:

<1> The software may be used on one computer.

<2> When the software is used on multiple computers, the
customer shall obtain licenses for the software as many as the
number of computers even if the software is not used at the
same time on those computers.

<3> When the software is read through the network to the
temporary memory of each computer, the customer shall
obtain license for the software as many as the number of
computers used.

<4> Only one copy of the software may be produced for backup.

Article 2 Copyright
FANUC possesses the copyright of the software. Accordingly, the
customer shall not copy the software for any purpose except for the
purpose stipulated in Article 1, "Licensing of right for use".

Article 3 Restrictions
The customer shall not transfer, lend, sell, distribute, lease, or rent
the software to a third party.

Article4 Warranty
If the distributed media or manual of the software contains a
physical defect, and the customer so notifies FANUC within ninety
days after the reception of the software, FANUC replaces the
defective item with a new one at no cost.

Article 5 Exemption
FANUC does not provide any warranty and guarantee related to the
software except the warrant stipulated in Article 4, "Warranty".
Namely, FANUC is not liable for any direct or indirect damages
arising from the use of the software.
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Abbreviations

In this manual, the following abbreviations may be used:

Abbreviations used in this manual

Term Abbreviation
Personal computer PC
Operating system 0S
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FUNCTION OVERVIEW

The Program Transfer Tool is a software tool running on a personal
program (PC) to input programs to and output them from CNC
memory or a data server. The CNC and PC are connected via

Ethernet.

NOTE
The available functions vary depending on the
Ethernet device and options of the CNC. See
Chapter 3, "OPERATING ENVIRONMENT".

The functions of this tool are outlined below.
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2.1 CONNECTION TO A CNC

To connect the tool to CNCs, an Ethernet is required.

Settings for communication with up to 255 CNCs are made in advance.
One of these CNCs is selected on the operation screen to perform
program transfer.

2.2 PROGRAM TRANSFER TO AND FROM THE PROGRAM
MEMORY

The following operations can be performed on the program memory
of the CNC:

(1) Downloading a program from the PC to the program memory

(2) Uploading a program from the program memory to the PC

(3) Displaying a list of programs stored in the program memory on
the screen

(4) Deleting a program in the program memory

(5) Displaying a list of tool offsets, custom macro common variables,
and workpiece origin offset data, which can be transferred
between the PC and CNC

(6) Transferring tool offsets, custom macro common variables, and
workpiece origin offsets between the PC and CNC.
When such data is uploaded, the format of the data is the same as
the format used when the data is output from the CNC to an
external device.

NOTE
When tool offsets, custom macro common variables
and workpiece origin offsets are downloaded from
the PC to CNC, they replace data in the CNC.

When the tool communicates with the Series 30i/31i/32i, the
following processing can also be performed:
(1) Downloading a folder and its subfolders and files from the PC to
the program memory
(2) Uploading a folder and its subfolders and files from the program
memory to the PC
(3) Deleting a folder in the program memory
(4) Renaming a file or folder in the program memory
(5) Creating a new folder in the program memory
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2.3 PROGRAM TRANSFER TO AND FROM A DATA SERVER

The following operations can be performed on external storage
devices (compact flash memory and hard disk drive) of a data
server:

(1) Downloading a file from the PC to the connection destination

(2) Downloading a folder and its subfolders and files from the PC to
the connection destination

(3) Uploading a file from the connection destination to the PC

(4) Uploading a folder and its subfolders and files from the
connection destination to the PC.

(5) Displaying lists of folders and files stored in the connection
destination

(6) Deleting a file or a folder in the connection destination

(7) Renaming a file or folder in the connection destination

(8) Creating a new folder in the connection destination

2.4 OPERATION ON FILES ON THE PC

The following operations can be performed on files and folders on
the PC:

(1) Displaying a folder tree and a file list

(2) Viewing and editing text files. The user can select a viewer for
viewing such files and an editor for editing them.

(3) Copying, moving deleting and renaming a file

(4) Creating, deleting, and renaming a folder

-11 -
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OPERATING ENVIRONMENT

This chapter explains the operating environment required for using
this tool.

Ethernet devices and CNC options

The following lists the Ethernet devices and CNC options required for
transferring files and non-program data to and from program memory
and a data server:

CNC type

Ethernet device used

CNC option required for
transferring files and

non-program data to and from

program memory

CNC option required for
transferring files and
non-program data to and
from data server (FTP
server setting required)

Series 30i /31i /32i -A

Embedded Ethernet

No option required (*1)

(Communication not enabled)

Fast Data Server board

Ethernet functions

Data Server functions

Series 16i /18i /21i -B

Embedded Ethernet

No option required (*1)

(Communication not enabled)

Ethernet board
Fast Ethernet board

Data Server board
Fast Data Server board

Ethernet functions

(Communication not enabled)

Data Server functions

Series 16i /18i /21i -A

Ethernet board
Fast Ethernet board

Data Server board
Fast Data Server board

Ethernet functions

Extended driver and libraries

function

(Communication not enabled)

Data Server functions

Embedded Ethernet

No option required

(Communication not enabled)

Fast Ethernet board

Ethernet functions

Series 0i -D
Fast Data Server board Ethernet functions Data Server functions
Series 0 -C Fast Ethernet board Ethernet functions (Communication not enabled)
Fast Data Server board Data Server functions
Fast Ethernet board (Communication not enabled)
Series 0i -B Built-in 1/0 board with Ethernet functions )
Data Server functions
data server
Series 20i -B Embedded Ethernet No option required (*1) (Communication not enabled)

Power Mate i -D/H

Ethernet board
Fast Ethernet board

Ethernet functions

Extended driver and libraries

function

(Communication not enabled)

*1 To use the embedded Ethernet function in the Series 32i-A,
Series 21i-B, and Series 20i-B, specify the main CPU board

with the embedded Ethernet function. No option is required
on the CNC side.

NOTE
1 For details of Ethernet devices, see Section 3.1, "CNC".
2 The PCMCIA LAN card is not supported.
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GENERAL

3.0PERATING ENVIRONMENT

3.1

CNC

Ethernet board or data server board and CNC options
The following table lists the Ethernet boards and data server boards
that can be used with this tool and necessary CNC options.

Ethernet board or data server board and required CNC options (1/3)

No Name Apr:Ic:t;:I:le Drawing number CNC option Control software
FS 16i /18i /21i A02B-XXXX-S707 *1
Ethernet board f -0236-
1 ernet board for TA/MA A02B-0236-J292 A02B-0207-J800 *2
LCD-mounted type FS 161 /181 /21
2 CNC PESLIETE | N02B-0281-J292 | A02B-XXXX-S707 *1
-TB/MB
e A02B-XXXX-S707 *1
FS 16i /18i /21
3 | ATA data server board _TIA/M/: " | A02B-0236-J145 | A02B-0207-J800 *2
for LCD-mounted type A02B-XXXX-S737 *3
CNC FS 16i /18i /21i A02B-XXXX-S707 *1
4 -TB/MB A02B-0281-J145 | ) 178 xxxX-5737 *3
FS 16i /18i /21i A02B-XXXX-S707 *1
5 Ethernet board for -TAIMA A02B-0265-J291 A02B-0207-J800 *2
stand-alone type CNC | FS 16i /18i /21i . A02B-0236-J561
6 TB/MB A02B-0281-J298 | A02B-XXXX-S707 *1 46561
e A02B-XXXX-S707 *1
FS 16i /18i /21
7 | ATA data server board _TIA/M/: " | A02B-0265-J145 | A02B-0207-J800 *2
for stand-alone type A02B-XXXX-S737 *3
CNC FS 16i /18i /21i A02B-XXXX-S707 *1
8 -TB/MB A02B-0281-J148 | ) 1oB xxxX-5737 *3
e A02B-XXXX-S707 *1
FS 16i /18i
9 A02B-0265-J154 A02B-0207-J800 *2
10 type CNC FS 16i /18i 28;3‘8;21‘;’123 A02B-XXXX-S707 *1
-TB/MB e 4 i A02B-XXXX-S737 *3
Power Mate i A02B-0259-J862 *5 | A02B-0259-J561
11 Ethernet board DM A02B-0259-J230 A02B-0259-1847 *6 46561
FS 16i /18i /21i A02B-XXXX-S707 *1 | A02B-0281-J561
12 -TA/MA A02B-0236-J293 A02B-0207-J800 *2 #6567
13 | Fast Ethernet board for | > 10 /181210 | ) 008 0281-0293 | A02B-XXXX-S707 *1 | A02B-0281-J561
-TB/MB #6567
LCD-mounted type A02B-0281-1561
14 CNC FS 0i-TC/MC A02B-0281-J293 | A02B-XXXX-S707 *1 #656\/\;
15 FS 0i-TC/MC A02B-0309-J293 | A02B-XXXX-S707 *1 Aozséggg\j\;wm
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Ethernet board or data server board and required CNC options (2/3)

No Name Apr::;(;:?le Drawing number CNC option Control software
FS 16i /18i /21i A02B-XXXX-S707 *1 A02B-0281-J561
16 -TAIMA A02B-0265-J293 | 5155 0207-J800 *2 #6567
Fast Ethernet board for | FS 16i /18i /21i . A02B-0281-J561
17 stand-alone type CNC TB/MB A02B-0281-J299 A02B-XXXX-S707 *1 46567
18 FS 0i-TB/MB A02B-0281-J299 A02B-XXXX-S707 *1 AOZB#%258617_J561
o ima A02B-XXXX-S707 *1
FS 16i /18i /21 - -
19 _T; /M/: " | A02B-0236-J140 | A02B-0207-J800 *2 AOZB#(;?; 1561
ATA fast data server A02B-XXXX-S737 *3
for LCD-mounted type FS 167 /18i /21i A02B-XXXX-S707 *1 A02B-0281-J561
20 CNC -TB/MB A02B-0281-J146 | ) o xxxx-5737 *3 #6567
. A02B-XXXX-S707 *1 A02B-0281-J561
21 FS 0i-TC/MC A02B-0281-J146 AO2B-XXXX-S737 *3 4656W
Fast data server . A02B-XXXX-S707 *1 A02B-0281-J561
FS 0i-TC/MC - -
22 for FS 0i-C =TC/ A02B-0309-J146 A02B-XXXX-S737 *3 #656W
 aos ima A02B-XXXX-S707 *1
FS 16i /18i /21 - -
23 | ATA fast data server _T; /M/: " | A02B-0265-J140 | A02B-0207-J800 *2 AOZB#(;?; 1561
for stand-alone type AQ2B-XXXX-S737 *3
CNC FS 167 /18i /21i A02B-XXXX-S707 *1 A02B-0281-J561
24 -TB/MB A02B-0281-J149 | ) o xxxx-5737 *3 #6567
Built-in I/O board
. A02B-XXXX-S707 *1 A02B-0281-J561
i FS 0i -TB/MB - -
25 (with data server) for i A02B-0299-H021 AO2B-XXXX-S737 *3 46567
stand-alone type CNC
re A02B-XXXX-S707 *1
26 RISC+ATA fast data FS 1,3;” 8i A02B-0265-J157 A02B-0207-J800 *2
A02B-XXXX-S737 *3 A02B-0281-J561
server for stand-alone A02B-0281-J161 46567
07 type CNC FS 16i /18i A0 ZB-O 08 1' e | AO2B-XXXX-S707 *1
-MB *4 A02B-XXXX-S737 *3
Embedded Ethernet for
LCD-mounted FS 16i /18i ) .
28 type/stand-alone type -TB/MB i Not required  *7
CNC A02B-0281-J571
Embedded Ethernet for #656A
LCD-mounted FS 21i . .
29 type/stand-alone type -TB/MB i Not required  *8
CNC *8
Power Mate i A02B-0259-J862 *5 A02B-0259-J555
30 Fast Ethernet board DIH A02B-0259-J293 A02B-0259-J847 *6 46567
Fast
Ethernet board for A02B-XXXX-S707 A02B-0303-J561
31 LeD-mounted FS 30:/31i/32i | A02B-0303-J146 *10 #6569
u -A *9 A02B-XXXX-S737 A02B-0303-J572
type/stand-alone type 11 4656F
CNC
Embedded Ethernet for A02B-0303-J571
LCD-mounted . . #656E
FS 30i /31i -A - i *
32 | {ype/stand-alone type s Notrequired ™2 | A028-0303-J572
CNC #656F
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Ethernet board or data server board and required CNC options (3/3)

No Name Apr:gzzllale Drawing number CNC option Control software
Embedded Ethernet for
33 LCD-mounted FS 32i -A - Not required *13
type/stand-alone type
CNC *13
Embedded Ethernet . . " A02B-0281-J571
34 *14 FS 20i-TB/FB - Not required *14 4656\
35 Fast Ethernet board FS 20i-TB/FB A02B-0281-J293 A02B-XXXX-S707 *1 AOZB#;ggg\}\;JSM
Fast
Ethernet board for . A02B-XXXX-S707 *1 | A02B-0319-J561
FS 0i -TD/MD - -
36 LCD-mounted type ! A02B-0319-J146 A02B-XXXX-S737 *3 #658W
CNC
*1  A02B-XXXX-S707: Ethernet  function for the  Series
16i/18i/211/0i/20i
This option is required when the tool communicates with the
program memory through an Ethernet board. When only the
function for communicating with the data server is used, this
option is not required.
XXXX specifies a drawing number according to the CNC type as
follows:
CNC type 16i -TA 161 -MA 16i -TB 16i -MB 18i -TA 18i -MA 18i -TB 18i -MB
Value of XXXX | 0236 0237 0281 0282 0238 0239 0283 0284
CNC type 21i -TA 21i -MA 21i-TB 21i -MB 0i -TB 0i -MB 0i -TC 0i -MC
Value of XXXX 0247 0248 0285 0286 0299 0300 0309 0310
CNC type 0i -TD 0i -MD 20i -TB 20i -FB
Value of XXXX 0319 0320 0287 0288
*2  A02B-0207-J800:  Extended driver and libraries for the Series
16i/18i /21i
This option is required when Model A is used.
When Model B is used, this option is unnecessary regardless of
whether the embedded function or external board is used.
*3  A02B-XXXX-S737: Data server function
This option is required when the function for communicating
with the data server is used.
XXXX specifies a drawing number according to the CNC type.
See *1.
*4  A02B-0281-J160 is a high-speed version of A02B-0281-J158.
A02B-0281-J162 is a high-speed version of A02B-0281-J161.
*5  A02B-0259-J862: Ethernet function for the PowerMate i-D/H
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*6

*7

*8

*9

*10

*11

*12

*13

*14

A02B-0259-J847: Extended driver and libraries for the
PowerMate i-D/H

When the embedded Ethernet function is used with the Series
16i/18i-TB/MB, no CNC option is required.

When the embedded Ethernet function is used with the Series
21i-TB/MB, the main CPU board with the embedded Ethernet

function must be specified. No CNC option is required.

A02B-0303-J146:  Fast Ethernet board for LCD-mounted type
and stand-alone type CNCs

This board provides the Ethernet function and/or the data server

function according to the CNC option used.

A02B-XXXX-S707: Ethernet function for the Series
301/31i/32i-A

This option is required for using the function for communicating
with programs. When only the function for communicating
with the data server is used, this option is not required. XXXX
specifies one of the following drawing numbers according to the
CNC type:

0303 (30i -A) 0307 (31i -A) 0308 (32i —A)

A02B-XXXX-S737: Data server function for the Series
301/31i/32i-A

This option is required for using the function for communicating

with the data server. XXXX specifies a drawing number

according to the CNC type. See *10.

When the embedded Ethernet function is used with the Series
30i/31i-A, no CNC option is required.

When the embedded Ethernet function is used with the Series
32i-A, the main CPU board with the embedded Ethernet function

must be specified. No CNC option is required.
When the embedded Ethernet function is used with the Series

20i-B, the main CPU board with the embedded Ethernet function
must be specified. No CNC option is required.

- 16 -



B-63344EN/01 GENERAL 3.0PERATING ENVIRONMENT

3.2 PERSONAL COMPUTER/HARDWARE

The following hardware is required for running this tool:
Computer

IBM PC/AT compatible machine
CPU: Pentium® 300MHz or higher is recommended.
Physical memory: 128MB or more
HDD: Free space of at least 30MB
Keyboard, mouse, and CD-ROM required.
Ethernet function required

Display

Resolution: 1024 x 768 dots or higher
e Color: 16 colors or more
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3.3 PERSONAL COMPUTER/SOFTWARE

When the OS is Windows Vista
(1) and (2) below are required:

(1) Microsoft Windows Vista® Business (32 bit version OS)
(2) Microsoft Internet Explorer 7.0 or later

NOTE
1 To do the following operations of this tool on
Windows Vista, the user must belong to the
Administrators group.
a) Installation
b) Uninstallation
c) Upgrade installation
2 This tool does not support the user switching
function of Windows Vista.

When the OS is Windows XP
(1) and (2) below are required:

(1) Microsoft Windows XP® Professional Service Pack 2 or later
(32 bit version OS)
(2) Microsoft Internet Explorer 6.0 or later

NOTE

1 To use this tool on Windows XP, the user must
belong to the Administrators group.

2 Only the user who has installed this tool can use
this tool.
This tool does not support the user switching
function of Windows XP.

When the OS is Windows 2000
(1) and (2) below are required:

(1) Microsoft Windows 2000® Professional ServicePack 4 or later
(2) Microsoft Internet Explorer 6.0 or later

NOTE

1 To use this tool on Windows 2000, the user must
belong to the Administrators group.

2 Only the user who has installed this tool can use
this tool.
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Supported Language
English, Japanese, and Simplified Chinese

The language displayed with this tool is automatically selected
according to the language of OS when you install this tool.

English will be selected if this tool is installed in OSs other than the
language of the above.
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INSTALLATION

This chapter explains the procedure for installing the Program
Transfer Tool.

NOTE

1 The screen images used in this chapter are screen
images on the Microsoft operating system
Windows Vista Business.

2 Toinstall and upgrade this tool, the user needs to
have the Administrator privilege.

3 In the following OS, only the user who has installed
this tool can use this tool.
- Windows XP

* This tool does not support the user switching
function.

- Windows 2000
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1.1 PREPARATION

This tool uses the TCP/IP protocol to communicate with a CNC via
Ethernet.

Make sure that the TCP/IP function is installed in the personal
computer in which this tool is to be installed and that the IP address
and subnet mask (and the default gateway if necessary) of the personal
computer are set.

1.2 INSTALLATION

To install this tool, use the setup program on the installation CD.

NOTE

1 To install this tool, the user must have the
Administrator privilege.

2 Before starting to install this tool, end all programs
being running.

(1) Start the computer, and set the installation CD.
When the installation CD 1is set, the installer is started
automatically.

Depending on the using OS and the settings on the personal
computer, it might be displayed as follows:
(a) AutoPlay dialog is displayed.
rClick the "Run setup.exe".
<o AutoPlay =HACH X

44 DVD RW Drive (L))
=»” ADSB_9510_J513

[} Always do this for software and games:

Install or run program
preg

& ™ Hun setup.exe

E - Oy b 1 e e e
-—hvf“' FUDlisner not epedanea

J

= L -
STETTETO TS LTOTT

Open folder to view files

i ieimn VWindowe Fynlorer

FINOOWS EXHONEr

Set AutoPlay defaults in Control Panel

(b) The file on the installation CD are displayed by the explore.
Start setup.exe on the installation CD.

(c) Nothing is displayed.
Start setup.exe on the installation CD with the explorer.
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(2) When the "User Account Control" screen is diplayed, click the
"Allow".
* The screen isn’t displayed depending on the using OS and the
settings on the personal computer.

Uszer &ccount Control |5

G.] An unidentified program wants access to your computer

Don't run the program unless you know where it's from or you've used it
before,

@ setup.exe
Unidentified Publisher

2 Cancel

I don't know where this pregram is from or what it's for.

2 Allow

Ttrust this program. I know where it's from or I've used it before,

() Details

User Account Control helps stop unauthorized changes to your computer.

(3) The installer start screen is displayed. _Click the <Next> button.
[ ﬁ Program Transfer Toal - InstallShield Wizard u

Welcome to the InstallShield Wizard for
Program Transfer Tool

The InstallShield(R) Wizard will install Program Transfer Tool on
your computer, To continue, dick Next.

WARNING: This program is protected by copyright law and
international treaties.
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(4) The terms in the software license agreement are displayed. Read
the license agreement carefully. When accepting the terms in the
license agreement, select the "I accept the terms in the license
agreement" and click the <Next> button.

# Program Transfer Tool - InstallShield Wizard

License Agreement

Please read the following license agreement carefully.

LICENSE AGREEMENT

|'»

This is an Agreement between vou and FANUC LTD {"FANUC") regarding the
Software Product ("the Software') which you receive with this Agreement. =

m

1.GRANT OF LICENSE

FANUC grants you the following right regarding the Software:

(1) You may use the Software on a single computer.

(2) In case you will use the Software upon the plural number of computers. the same
number of license to use the Software as that of the computers on which you will use
the Software shall be required even though you will not use the Software

@) I accept the terms in the license agreement!

(71 I do not accept the terms in the license agreement

InstallShield

[ < Back ][ Next = J [ Cancel J

(5) Determine the installation folder. Check the "Install Program
Transfer Tool to". To install the tool in the indicated destination
folder, click the <Next> button. To change the destination folder,
click <Change>, select a folder, then click the <Next> button.

ﬁ Program Transfer Toaol - InstallShield Wizard ﬁ
Destination Folder
Click Mext to install to this folder, or dick Change to install to a different
@ Install Program Transfer Tool to:
C:\Program Files\FANUC\Program Transfer Tool}
Installshield
< Back ][ Next = J [ Cancel
(-
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(6) Click the <Install> button. Installation then starts.

# Program Transfer Tool - InstallShield Wizard u

Ready to Install the Program
The wizard is ready to begin installation.

Click Install to begin the installation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard,

Instzlishield

| <Bak | msal || cancel |

(7) When installation is completed, the screen shown below is
displayed.
Click the <Finish> button to exit the installer.
[ ‘ﬁ Program Transfer Toaol - InstallShield Wizard u

InstallShield Wizard Completed

The InstallShield Wizard has successfully installed Program
Transfer Tool. Click Finish to exit the wizard.

This completes the installation.

NOTE
It is necessary to set the Windows Firewall to
communicate with DATA SERVER with some of
Windows OS.
Refer to the Appendix B, "Windows Firewall

Settings".
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1.3 UPGRADE INSTALLATION

By the upgrade installation, you can upgrade this tool without
uninstalling the old version.
After upgrading, setting items in the old version can be used as it is.

To upgrade this tool, use the setup program on the upgrade CD.

NOTE

1 The Program Transfer Tool cannot be installed
only by the upgrade CD.

2 To upgrade this tool, the user must have the
Administrator privilege.

3 Before starting to upgrade this tool, terminate all
programs being running.

4 The serial numbers of the following specification
are necessary to upgrade.
- Program Transfer Tool (AO8B-9510-J513)
- Program Transfer Tool Upgrade

(A08B-9510-J514)

The procedure of the upgrade installation is different depending on the

version of the Program Transfer Tool that has already been installed.

When the version is prior to 2.0, refer to (a). When the version is 2.0

or later, refer to (b).

* You can confirm the version by selecting the [Version] in the [Help]
menu of the Program Transfer Tool Settings screen.

(a) The version of Program Transfer Tool that has already been installed is prior
to 2.0.
(1) Back up the settings of the Program Transfer Tool that has already
been installed.
About the backup procedure, refer to the "1.6 MAINTENANCE
OF SETTINGS" in the "Part III. SETTING".
NOTE
Don’t store the backup file in the folder that
have been installed the Program Transfer Tool.
This folder is removed when uninstalling.
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2)

)

4)

Uninstall the Program Transfer Tool that has already been
installed.

Before uninstalling, write down the folder name where the version
1.0 is installed.

About the uninstallation procedure, refer to the "2
UNINSTALLATION".

NOTE
Uninstall from the "Uninstall a program" or the
"Add/Remove Programs" in the "Control Panel"
of Windows. Don’t uninstall by using the
installation CD.

When the upgrade CD is set, the installer is started automatically.
The installer isn’t started automatically depending on the using
OS and the settings on the personal computer. Refer to the (1)
and the (2) in the "1.2 INSTALLATION", start the installer.

The information on the necessary serial number is displayed.
When you continue installing, click the <Yes> button.

[

e

Program Transfer Tool Installer Information &J

i - 1 It is necessary to register the following two serial numbers to use the
" Program Transfer Tool.
& Prograrm Transfer Tool (AO8E-9510-]513)
Prograrn Transfer Tool upgrade (A0S8B-9510-J514)

De you continue installing of the Program Transfer Tool upgrade ?

)

(6)

(7

Install the version 2.0 to the folder where the version 1.0 had
installed. The installation procedure after this is similar to the
normal installation procedure. Refer to the (3) or later in the "1.2
INSTALLATION".

After the installation is completed, start the Settings screen.
Enter the serial numbers of the following specification.

- Program Transfer Tool (A08B-9510-J513)

- Program Transfer Tool Upgrade (A08B-9510-J514)

Restore the settings of the Program Transfer Tool backed up on
the (1).

About the restoration procedure, refer to the "1.6
MAINTENANCE OF SETTINGS" in the "Part III. SETTING".
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(b) The version of the Program Transfer Tool that has already been installed is
2.0 or later.
(1) When the upgrade CD is set, the installer is started automatically.
The installer isn’t started automatically depending on the using
OS and the settings on the personal computer. Refer to the (1)
and the (2) in the "1.2 INSTALLATION", start the installer.

(2) When upgrading, click the <Yes> button.
Program Transfer Tool ﬁ

r’ This setup will perferm an upgrade of 'Program Transfer Tool'. Do you
' want to continue?

(3) The versions of each program are displayed. To continue, click
the <Yes> button.
Program Transfer Tool Installer Information ﬁ

3 Do you want to upgrade this program?

Y Installed program versicn: 2.0.0
Upgrade Installer version: 3.0.0

4) Click the <Next> button. The upgrade installation starts.
pg
ﬁ! Program Transfer Tool - InstallShield Wizard u

Welcome to the InstallShield Wizard for
Program Transfer Tool

The Installshield{R) Wizard will install Program Transfer Tool on
your computer. To continue, dick Mext,

WARNIMG: This program is protected by copyright law and
international treaties.
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(5) The information on the folder where the backup is preserved is
displayed. Click the <OK> button.
Program Transfer Tool Installer Information [==5)

G Installer makes backup of already installed Program Transfer Tool to the
WY following folder;
Ci\Program Files\FAMUC Program Transfer
TochBackup-v2.0.0_080512020403

(6) When the upgrade installation is completed, the screen shown
below is displayed.
Click the <Finish> button to exit the installer.

rﬁ Program Transfer Tool - InstallShield Wizard u

InstallShield Wizard Completed

The Installshield Wizard has successfully installed Program
Transfer Tool. Click Finish to exit the wizard.

Cancel

(7) Start the Settings screen, and enter the serial number of the
following specification.
- Program Transfer Tool upgrade (A0O8B-9510-J514)
If the serial number of the Program Transfer Tool
(A08B-9510-J513) has not been entered, it is necessary to enter
the serial number of the Program Transfer Tool too.
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UNINSTALLATION

This chapter explains the procedure for uninstalling the Program
Transfer Tool.
This tool is uninstalled by using one of the following two ways.
(1) <Windows Vista>
Use the "Uninstall a program” in the "Control Panel" of
Windows.
<Windows XP or Windows 2000>
Use the "Add/Remove Programs" in the "Control Panel" of
Windows.
(2) Use the installation CD.

Normally, uninstall the program by using "Add/Remove Programs" in

(1).

NOTE

1 The screen images used in this chapter are screen
images on the Microsoft operating system
Windows Vista Business.

2 To uninstall this tool, the user needs to have the
administrator privilege.

3 Before starting uninstallation, end all running
programs.

Using "Add/Remove Programs™ to uninstall this tool

(1) Choose [Start] — "Control Panel"” of Windows to display the
"Control Panel" screen.

(2) Click the "Uninstall a program" on the "Control Panel".

(3) From a list of installed programs, select "Program Transfer Tool",
and click [Uninstall]. The uninstaller then starts.

(==

@Qdﬁ + Control Panel » Programs » Programs and Features + [ 43| [ search 2|

Tasks ’
= Uninstall or change a program

Wiew installed updates

. To uninstall a program, select it from the list and then click "Uninstall”, "Change", or "Repair”.
Get new programs online at

Windows Marketplace _
. Organize -~ |= Views @ ®
View purchased software - . o

(digital locker) MName Publisher Installed On

3 Turn Windows features on or  HECLI-MEIMRIERF g b FANUC S/12/2008  :
off
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(4) A message box appears to ask the user whether to uninstall the
tool. Click the <Yes> button.

Programs and Features

-

I  Areyou sure you want to uninstall Program Transfer Tool?
o

] Inthe future, do not show me this dislog box | Yes | I Mo ]

(5) When the "User Account Control" screen is diplayed, click the
"Allow".
* The screen isn’t displayed depending on the using OS and the
settings on the personal computer.

User Account Control @

-
@ An unidentified program wants access to your computer

Don't run the program unless you know where it's from or you've used it
before.

@ Unidentified Publisher

< Cancel
I don't know where this program is from or what it's for.

< Allow

Ttrust this program. [ know where it's from or I've used it before,

() Details

User Account Control helps stop unautheorized changes to your computer.

(6) The folders that installed the Program Transfer Tool and it’s
subfolders are will be deleted. Confirme that a necessary file
such as backup files doesn't exist. When it is no problem, click
the <Yes> button.

[ Program Transfer Tool Installer Information [%J

% The C:\Program Files\FANUC\Program Transfer Tool folder and it's sub
W folder will be deleted.
Do you want to uninstall this program?

(7) When the uninstallation is completed, the "Program Transfer
Tool" is removed from the list of the (3).
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Using the installation CD to uninstall the tool

(1) When the installation CD is set, the installer is started
automatically.
The installer isn’t started automatically depending on the using
OS and the settings on the personal computer. Refer to the (1)
and the (2) in the "1.2 INSTALLATION", start the installer.

(2) The maintenance program is started. Click the <Next> button.
ﬁ Program Transfer Tool - InstallShield Wizard u

Welcome to the InstallShield Wizard for
Program Transfer Tool

The Installshield(R) Wizard will allow you to modify, repair, or
remove Program Transfer Tool. To continue, dick Next,

< ﬁ-acki'

(3) After selecting the [Remove], click the <Next> button. .
ﬁ Program Transfer Tool - InstallShield Wizard u

Program Maintenance

Maodify, repair, or remove the program.

) Modify

Change which program features are installed. This option displays the
Custom Selection dialog in which you can change the way features are
installed.

Repair installation errors in the program. This option fixes missing or
corrupt files, shortcuts, and registry entries.

Remove Program Transfer Tool from your computer,

InstallShield

[ <Bak |[ mext> || canel |
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(4) The confirmation screen of the uninstallation is displayed. Click
the <Remove> button.

ﬁ! Program Transfer Tool - InstallShield Wizard M

Remove the Program

‘You have chosen to remove the program from your system,

Click Remove to remove Program Transfer Tool from your computer. After removal, this
program will no longer be available for use.

If you want to review or change any settings, dick Badk,

InstallShield

[ < Back IE Remove | [ Cancel I

(5) The folders that installed the Program Transfer Tool and it’s
subfolders are will be deleted. Confirme that a necessary file
such as backup files doesn't exist. When it is no problem, click
the <Yes> button.

Program Transfer Tool Installer Information M

-

&' folder will be deleted.

Do you want to uninstall this program?

@ The C:\Program Files\FANUC\Program Transfer Tool folder and it's sub
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(6) When the uninstallation is completed, the screen shown below
appears. Click the <Finish> button to exit the maintenance
program.

ﬁ Program Transfer Tool - InstallShield Wizard u

InstallShield Wizard Completed

The InstallShield Wizard has successfully uninstalled Program
Transfer Tool. Click Finish to exit the wizard.
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SETTING 1.SETTING

SETTING

On the setting dialog, set the machine with which this tool is to
perform data transfer.

Program Transfer Tool Settings
File

Machine Mo: |4 -

Serial Mo Maintenance Help

Machine Info. T PrngramMemuryT Data Server T Dizplay

b achine Mame; |Man ame_001
CNC Type: | Dther =l

Contral Path: 1 -

Cancel Euit

On the setting dialog, set the following:

(1)

2)
3)
4)
)

Serial No

Enter the factory-set serial number provided together with the
installation CD. Unless the serial number is entered, settings
cannot be made on the setting dialog.

Machine Info.

Set the machine name, the CNC type, and the number of paths.
Program Memory

Make settings for communicating with the program memory.
Data Server

Make settings for communicating with the data server.

Display

Make display-related settings.
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Starting setting

Ending setting

Setting method

Choose "Setting dialog" in the "Program Transfer Tool" group.

NOTE
It is impossible to use the Program Transfer Tool
and the setting dialog at the same time.
- Before starting setting, end the Program Transfer
Tool.
- Before using the Program Transfer Tool, end the

setting dialog.

Click the <Exit> button. Alternatively, click [Exit] in the [File]
menu.

Setting items are classified by function into tabs.

Set items by following the steps below.

(1) Select a machine No.

(2) Make settings, then click the <Save> button or click [Save] in the
[File] menu.

(3) Click the <Exit> button or click [Exit] in the [File] menu to end
the screen.

To cancel the settings made so far, click the <Cancel> button.
However, settings once saved by <Save> cannot be canceled.

When the user selects another machine No. or clicks the Exit button
without clicking the Save button after making settings, a message
appears to ask the user whether to save the settings. To save the
settings, click the <OK> button.
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1.1

SERIAL NUMBER

This figure is an example.
Please input a correct serial —» |1234.1 23412341 23412341234

number.

This figure is an example.
Registered specification ————,
number and serial number

will be displayed.

To use the Program Transfer Tool, the serial number provided
together with the installation CD must be entered on the setting dialog.
Unless the serial number is entered, it is impossible to make settings.
Once the serial number is entered, it need not be entered again.

Click [Admin] in the [Serial No] menu. The "Serial No.
administration" dialog box is then displayed. Enter the serial number
provided together with the installation CD of the Program Transfer
Tool.

Serial Mo, administration

Serial Mo, setting

Registered Senal Mo.
AN8E-9510-J51303.0.0] [Serial Mo, iz not registered.

Cancel | E xit

(1) Serial No. setting
Enter a 24-digit serial number. When a lowercase letter is
entered, it is converted to the uppercase letter. An already
registered serial number cannot be entered.

(2) Registered Serial No.
Registered serial No. and specification number will be displayed.
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1.2

MACHINE INFO.TAB

Program Transfer Tool Settings

Eile Serial Mo Maintenance Help

Machine Mo |4 -

Machine Info. T F'ru:ugramMemc:ryT Data Server T Dizplay

M achine Name: |ManamE_|:|U'|
CNC Type: | Olther ﬂ

Contral Path: 1 -

Cancel Exit

Set machine information in the Machine Info. tab.

(1)
2)

)

Machine No

Select a machine number for which settings are to be made.
Machine Name

Set a name consisting of up to 40 one-byte characters (up to 20
two-byte characters) for each machine. It is impossible to
delete a machine name or to set the same name as the name of
another existing machine. Names are case-sensitive. The
machine name set here is displayed in the machine list of the
Program Transfer Tool.

The default is "McnName XXX", where XXX is a 3-digit
machine number.

CNC Type

Select the type of the CNC.

NOTE
If the type of the CNC selected and the type of
the CNC connected are different, it is not
possible to use this tool.

(4) Control Path

Select the number of paths controlled by the CNC.
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Automatic setting through communication

When communication with the CNC via FOCAS2/Ethernet is enabled,
CNC Type and Control Path can also be set through communication
with the CNC. If communication with the CNC is enabled when
these items are set, automatic setting through communication should
be performed to prevent setting errors.

For details, see (9), "Set Machine Info. by Communication", in
Section 1.3, "SETTING COMMUNICATION WITH PROGRAM
MEMORY".
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1.3

SETTING COMMUNICATION WITH PROGRAM MEMORY

Program Transfer Tool Settings

File Serial No Maintenance Help

Machine Ma: |4 -

M achine [nfo. T Program Hemur_pT Data Server T Digplay

[v Communicate with Program Memory
Program kemaory Communication S ettings
Ethemnet Type: |Em|:ueu:|u:|eu:| Ethemet ﬂ

IP Address: |‘|E|2,‘|E;EE_EI,‘I

TCF Part Mo o193
Cormmunication imeout[sec]: 10

0 rwumber digitz
(= 4 digits (" Bdigitz
Comrmunication setting confirmation Set Machine Info. by Communication

Cancel Exit |

In the Program Memory tab, settings are made to communicate with a
program memory to transfer data other than programs.

(1)
2

)

Machine No

Select a machine number for which settings are to be made.

Communicate with Program Memory

When communication with the program memory is to be

performed, check this check box. This enables setting in this

tab.

If this check box is not checked, setting in this tab cannot be

performed.

Ethernet Type

For communication with the program memory, select which type,

[Embedded Ethernet] or [Ethernet Board/DATA SERVER], is to

be used.

(A) When [Embedded Ethernet] is selected
The IP address used for the program memory and the IP
address used for the data server must not be set to the same
value.

(B) When [Ethernet Board/DATA SERVER] is selected
The IP address used for the program memory and the IP
address used for the data server must not be set to different
values.When [Ethernet Board/DATA SERVER] is selected,
it becomes impossible to set an IP address in the Data
Server tab, and the IP address set in the Program Memory
tab is displayed.
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4)

)

(6)

(7

(®)

©)

IP Address
Enter the value set as the IP address of the CNC. Up to 63
one-byte characters can be entered. This item is always
required. The value to be set must not be the same as the value
set as the [P address for another machine. A host name may
also be entered. When a host name is used, it is not case
sensitive. For the setting method for each CNC, see Appendix.
TCP Port No.

Enter the value set as the TCP port number of the CNC. This
item is always required. A value from 5001 to 65535 can be
entered. The default is 8193. For the setting method for each
CNC, see Appendix.

Communication timeout

Enter a timeout period in seconds to be applied during
communication. This item is always required. A value from 0
to 600 can be entered. If 0 is entered, the tool waits infinitely
without causing a timeout. The default is 10.

O number digits

When connecting the tool to a CNC that can use 8-digit O
numbers, check 8 digits. The default is 4 digits.
Communication setting confirmation

Correct communication with the CNC can be confirmed. After
adding or modifying settings in this tab, be sure to confirm
communication. For details, see Subsection 1.3.1, "Confirming
Communication Settings".

Set Machine Info. by Communication

CNC Type and Control Path, which are entered in the Machine
Info. tab, can be set through communication with the CNC.

When this button is clicked, communication with the CNC is
performed to obtain the values of CNC Type and Control Path,
and the following message is displayed:

Program Transfer Tool Settings (=5

Do you set the CMC type, Control path, and O number digits as follows?
CMC Type = [Series 30i]
Control Path = [10]
O number digits = [4]

Cancel

When the OK button is clicked, the indicated values are set.
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1.3.1 Confirming Communication Settings

When the <Communication setting confirmation> button in the
Program Memory tab is clicked, a screen for confirming
communication settings is displayed.

This subsection shows screen examples displayed when the settings
are correct and when there are setting errors and explains how to
correct these setting errors.

NOTE
The buttons on the screen are used for checking
communication problems.
In normal operation, these buttons must not be
used.

Screen display when the settings are correct
If the IP addresses of the PC and CNC are correct, and the power to
the CNC is on, a screen as shown below is displayed:

E?E Ethernet communication test = [ =[]
Help
IPadd  |192.168.01 |

Pingl) | FOC&5221 | FTPE |

FingCount 4 Ping

PIMG test...

" " 00071 Reply From 192.168.0.7; bytes=32 time=1msz TTL=128
(1) "PING test..." < | |0002 Reply From 192.163.0.1: butes=32 tine=Oms TTL=123
0003 Reply From 192.168.0.7; bytes=32 time=0mz TTL=128
L 0004 Reply From 192.168.0.7; bytes=32 time=0mz TTL=128

Get Spztem Information test....
CMC Type 30

W AT MT

(2) "Get System Information test.." Serise 000

Wergion  #0d

bl @ ez 32

Aues 04
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(1) "PING test..." shows the results of a PING command test for the
CNC.
(2) "Get System Information test..." shows CNC system information.
CNC Type: Indicates the type of the CNC.
Number: Indicates the model number of the i Series.
Example: 30 represents the Series 30 i.

PD: Power Mate i -D
PH: Power Mate i -H
M/T: Indicates the M/T type.
Series: Indicates the series number of the CNC
software with a 4-digit character string.
Version: Indicates the version number of the CNC
software with a 4-digit character string.
Max axes: Indicates the maximum number of axes that
can be controlled.
Axes: Indicates the number of controlled axes.
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Retesting on the communication confirmation screen

Setting error (1)

Retesting for confirming communication can be performed without

ending this screen and returning to the communication setting dialog,

by following the steps below:

(1) Enter the IP address of the communication destination in
[IpAddr].

(2) Click the <All Test> button.

When communication confirmation has been performed by retesting,

re-enter correct values on the communication setting dialog.

-

E?E Ethernet communication test El@

Help
IP Addr [192.168.0.1 |

Ping(1) | FOCes2@) | FTPE) |

FingCount 4 Fing

...........................................

............................................

FING test...

ICHP_Error:0

ICKMP_Error0

ICMP_Errord

ICMP_Error0

Cannot ping to the T arget.

Fleaze check Target's address, cable and poveer

If the IP addresses of the PC and CNC are not correct, or if the power
to the CNC is off, a screen as shown below may appear:

When "Reply From ..." lines are not displayed, possible causes are as

follows:

(1) The power to the CNC is off, or there is a cable not connected.

(2) The IP address of the CNC and the setting on the setting dialog
do not match.

(3) The set CNC network address and host address are incorrect.

For the IP address, refer to the manual of the Ethernet board.
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Setting error (2)

If the IP addresses of the PC and the CNC are correct, and the power
to the CNC is on, but another setting error is present, a screen as
shown below may appear:

Eﬂ Ethernet communication test o[ 5[]
Help
IF Addr [192.166.0.1 -]
Ping(1) | FOC&s2@) | FTPE) |
FingCount |4 Ping
Lo tiTest
PIMG test...

0001 Reply From 192.168.0.1; bytes=32 time=1m= TTL=128
0002 Reply From 192.168.0.1; bytes=32 time=0ms TTL=128
0003 Reply From 192.168.0.1; bytes=32 time=0ms TTL=128
0004 Reply From 192.168.0.1; bytes=32 time=0m= TTL=128

et Sypstem [nformation test.. .
Allocate Handle eror=-16

If no CNC system information is displayed following the "Get System

Information test...." line, possible causes are as follows:

(1) The set IP address is not the IP address of the CNC but the IP
address of a device such as a PC for which TCP/IP is set.

(2) The value set in "TCP Port No." of the CNC is incorrect.

(3) The CNC is provided with a data server option, and
communication parameters are correct, but there is no Ethernet
option.

If "No option (Extended driver and libraries function)" is indicated,
the extended driver and libraries option is missing in the CNC.
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1.4

SETTING COMMUNICATION WITH DATA SERVER

Program Transfer Tool Settings
File Serial Mo Maintenance Help
Machine Mo: |4 -
M achine Info. T Program b ermory T Data Server T Digplay
v Communicate with D ata Server
Daata Server Communication Settings
IP Address: 1192.168.0.1
Izer Mame: ||:It$\-'r
Pagzword: —
FTP Paort Mo 21
Login Folder: |
Communication setting confirmation
Cancel E uit

In the Data Server tab, settings are made to communicate with the FTP
server of a data server.

(1)
2)

)

Machine No

Select a machine number for which settings are to be made.
Communication with Data Server

When communication with the FTP server of the data server is to
be performed, check this check box. This enables setting in this
tab.

If this check box is not checked, setting in this tab cannot be
performed.

IP Address

Enter the IP address set for the CNC. Up to 63 one-byte
characters can be entered. This item is always required. The
value to be set must not be the same as the value set as the IP
address in data server communication settings for another
machine. A host name may also be entered. When a host
name is used, it is not case sensitive. For the setting method for
each CNC, see Appendix.

When communication with the program memory is enabled, and
[Ethernet Board/DATA SERVER] is selected as the Ethernet
type, the IP address entered in the Program Memory tab is used,
so no IP address can be entered in the Data Server tab.
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4)

)

(6)

(7

(®)

User Name

Enter the user name set for the CNC. Up to 31 one-byte
characters may be entered. This item is always required. The
default is "dtsvr". For the setting method for each CNC, see
Appendix.

Password

Enter the password set for the CNC. The entered characters are
indicated with asterisks (*). Up to 31 one-byte characters may
be entered. This item is always required. The default is
"dtsvr". For the setting method for each CNC, see Appendix.
FTP Port No.

A value from 1 to 65535 can be entered. This item is always
required. The defaultis 21. Normally, use the default without
modification.

Login Folder

Enter a login folder if it is specified. Up to 128 one-byte
characters may be entered. This item may be omitted.
Communication setting confirmation

Correct communication with the data server can be confirmed.
After adding or modifying settings in this tab, be sure to confirm
communication. For details, see Subsection 1.4.1, "Confirming
Communication Settings".
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1.4.1 Confirming Communication Settings

When the <Communication setting confirmation> button on the data
server communication setting dialog is clicked, a screen for
confirming communication settings is displayed.

This subsection shows screen examples displayed when the settings
are correct and when there are setting errors and explains how to

correct these setting errors.

NOTE
communication problems.

used.

The buttons on the screen are used for checking

In normal operation, these buttons must not be

Screen display when the settings are correct

(1) PING test <

N\

(2) FTP Connect test <

~
~

(3) FTP Directory List test 3

E‘E Ethernet communication test
Help
IP Addr [192.168.0.1 |

Pinall) | FOC4522) | FTPE) |

(===

Uszermarne dratr
Pazsword i

Connect Test

FIMNG test...

FTP Connect test...

220 FAMNUC FTP server ready.

331 Uszer name okay, need pazsword.
230 Uzer lagaed in, procesd.

257" iz cument directon.

M ame Size
Folder1/

Q0o A00
File00o01 3500
4 L1

0001 Reply From 192 168.0.1: bytez=32 time=1mz TTL=128
1002 Reply From 192.168.0.1; bytes=32 time=0ms TTL=128
0003 Reply From 132.168.0.1; bytes=32 time=0ms TTL=128
0004 Reply From 192.168.0.7; bytes=32 time=0mz TTL=128

m
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When the settings are correct, (1) to (3) are all displayed. Their
meanings are as follows:

(1)

"PING test" shows the results of a PING command test for the
communication destination. If the communication settings are
correct, "Reply from ..." is returned from the communication
destination as shown in the figure.

(2) "FTP Connect test" shows the results of a test of connection to

the communication destination. If the communication settings
are correct, a message indicating the current directory set after
login is displayed, such as "257 "/NCDATA" is current
directory" displayed in the last line.

(3) "FTP Directory List test" shows the results of testing the display

of the directory of the communication destination. If the
communication settings are correct, a list of folders or files in the
current folder set immediately after login is displayed.

After this test, a logout takes place.

If the data server contains neither files nor folders, the following
is displayed without displaying a file or folder list:

Meanings of messages displayed by the FTP Connect test

Th

e message displayed with a number varies depending on the

specification of the communication destination software. The

fol

lowing shows the meanings of the numbers and display examples in

a data server:

No.

Meaning and display example in data server

220

The communication destination becomes ready for accepting a new user.
Example: FANUC FTP server ready.

331

Login starts, and a password is requested.
Example: User name okay, need password.

230

Login is completed.
Example: User logged in, proceed.

257

The path name (the current directory in the test) has been changed.
Example: "/NCDATA" is current directory.

530

Login has not been performed.
Example: Not logged in.

Retesting on the communication confirmation screen

Re

testing for confirming communication can be performed without

ending this screen and returning to the communication setting dialog,

by

following the steps below:

(1) Enter the IP address of the communication destination in

[IpAddr].

(2) Enter the user name in [Username].

(3) Enter the password in [Password].

(4) Click the <Connect Test > button.

When communication confirmation has been performed by retesting,

re-

enter correct values on the communication setting dialog.
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Setting error (1)
If the IP address of the communication destination is not correct, or
the power to the communication destination is off, "(1) PING test"
may appear as shown below.

Eﬂ Ethernet cormmmunication test EI@

Help
1P Addr [192.166.0.1 |

Fingll) | FOCAs221 | FTPE) |

Usemame dewr Connect Test
Pazzword e ;

FIMG test...

[CHP_Error0

ICMP_Error0

[CHMP_Error0

ICMP_Error0

Canrnot ping to the Target.

Fleaze check Target's addresz, cable and power

When "Reply From ..." lines are not displayed, possible causes are as

follows:

(1) The power to the CNC is off, or there is a cable not connected.

(2) The IP address of the CNC and the setting on the setting dialog
do not match.

(3) The setting of CNC network address and host address are
incorrect.
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Setting error (2)
If the connected data server does not use the FTP server function, "(2)
FTP Connect test" may fail even when "(1) PING test" succeeds.
In this case, a message indicating that the communication destination
is ready to accept the user, such as "220 FANUC FTP Server ready",
is not displayed, but "Cannot connect ..." is displayed. Set a correct
connect destination.

E?E Ethernet cormmunication test EI@

Help
IPadd  [192168.0.1 |

Pingl) | FoCAs22) | FTPE) |

Uszemame dbzer Connect Test
Paszzwaord s i

FIMNG test...

0001 Reply From 192.168.0.1; bytes=32 time=1m=s TTL=128
0002 Reply From 192.168.0.1; bytes=32 time=0ms TTL=128
0003 Reply From 192.168.0.1; bytes=32 time=0m=s TTL=123
0004 Reply From 192.168.0.1; bytes=32 time=0ms TTL=128

FTF Connect test. .
Cannat connect ..

If a screen as shown above is displayed, possible causes are as

follows:

(1) The FTP server setting for the data server is incorrect or is not
found.

(2) The ATA card of the data server is not present or fails, so the
FTP server function is disabled.
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Setting error (3)

If the set user name or password is incorrect, "(2) FTP Connect test"
may fail even when "(1) PING test" succeeds. In this case, a
message indicating that the communication destination is ready to
accept the user, such as "220 FANUC FTP Server ready.", is
displayed, but a message indicating that login failed, such as "530 Not
logged in.", is displayed.

Eﬂ Ethernet communication test o[ 5[]

Help
1P Addr [192.168.0.1 -]

Finall) | FoC2s221 | FTPE |

Uzemame dswr Connect Test
Pazsword e ;

FIMNG test...

0001 Reply From 192.168.0.1; bytes=32 time=1ms TTL=128
0002 Reply From 192.168.0.1; bytes=32 time=0ms TTL=128
0003 Reply From 192.168.0.1; bytes=32 time=0m= TTL=128
0004 Reply From 192.168.0.1; bytes=32 time=0ms TTL=123

FTP Connect test...

220 FAMUC FTP zerver ready.

331 Uzer name okay, need paszword.
530 Mat logged in.

If a screen as shown above is displayed, a possible cause is as follows:
(1) The user name or password is incorrect. It is necessary to enter
uppercase and lowercase letters correctly.
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1.5

DISPLAY

Program Transfer Tool Settings

Eile Serial Mo Maintenance Help

Machine Mo: - |4 -

b achine Info. T F'ru:ugramMemur_l,lT Data Server T Dizplay

PC folder to be dizplayed when communication iz started:

CAMcData
E stenzion for part program file icon;

CMC device for communication startup:

{* Program kemary (" Data Server

Save Cancel Euit

In the Display tab, items related to display are set:

(1)
2)

3)

Machine No

Select a machine number for which settings are to be made.

PC folder to be displayed when communication is started

Set the folder on the PC that is to be displayed in the PC file list
of the Program Transfer Tool when communication with the
machine starts. Clicking the right button displays PC folders
for selection. This item is always required. A folder name
consisting of up to 248 characters can be specified without
adding \ at the end.

Extension for part program file icon

The Program Transfer Tool can display a special icon to

represent programs so that they can be distinguished from other
files.

L=,

HG

Set an extension to display the icon for programs. Up to 5
one-byte characters can be entered. This item may be omitted.
Example:

To display a file having file name "xxx.PRG" with the

program icon, enter the following:

"PRG"
When a program is uploaded from the program memory of CNC
except Series 30i/31i/32i to PC, the extension set here is added to
the program name automatically.

Program icon
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(4) CNC device for communication startup
This item specifies whether to display a program memory list or
data server list when the Program Transfer Tool starts to
communicate with the machine.
When "Communicate with Program Memory" is checked in the
"Program Memory" tab, the <Program Memory> button becomes
valid.
When "Communicate with Data Server" is checked in the "Data
Server" tab, the <Data Server> button becomes valid.
When both buttons are valid, the user can select one of these
buttons.
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1.6 MAINTENANCE OF SETTINGS

When [Saving and Restoring of Settings] is chosen from the
[Maintenance] menu, the "Saving and Restoring of Settings" dialog
box is displayed. By using this dialog box, settings can be saved in
one setting file. It is also possible to restore settings by reading a
setting file.

Saving and Restoring of Settings

Festore E xit

(1) Backup
Settings are backed up in one file. Click the <Backup> button
to display the "Save As" dialog box. Specify a folder and a file
name.

(2) Restore
Backed up settings are restored. Click the <Restore> button to
display the "Open" dialog box. Settings are then read from a
specified backup file.

(3) Exit
This button ends this dialog box.
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1.7 MENU

File menu

Serial No. menu

Maintenance menu

The following menu functions are provided on the screen:

Cancel

Save

Exit

Admin

Saving and
Restoring of
Settings

Cancels settings made by modification, and reads the
most recently saved data. The same function as the
<Cancel> button on the screen is provided.

Saves settings made by modification. The same
function as the <Save> button on the screen is
provided.

Ends the screen.The same function as the <Exit>
button on the screen is provided.

Inputs a serial number. For details, see Section 1.1,
"SERIAL NUMBER".

Backs up or restores settings. For details, see
Section 1.6, "MAINTENANCE OF SETTINGS".
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OPERATION 1.OPERATION

OPERATION

This chapter describes the method of operating the tool.

Chapter 1, "OPERATION", consists of the following sections:

1.1
1.2

1.3
1.4

1.5
1.6
1.7

STARTING THE TOOL ......ccccciviiiiinieiinieeneeecreeeeeene 64
SCREEN CONFIGURATION OF THE PROGRAM
TRANSFER TOOL .....ccoooiiiiiiiieiiieeeeieeeeneeeere e 64
PC FILE LIST OPERATION .......ooctviiiininieineceeieeeeienieeeen 68
FILE TRANSFER TO AND FROM THE PROGRAM
MEMORY ..ottt e 77
TRANSFER OF DATA OTHER THAN PROGRAMS ............ 95
FILE TRANSFER TO AND FROM THE DATA SERVER...103
SETTING OF OPTIONS......cceoieieiinieenieceeieeeeeeeseene e 118
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1.1 STARTING THE TOOL

Starting the tool

Choose <Program Transfer Tool> from the [Program Transfer Tool]
group on the [start] menu of Windows.

NOTE
The Program Transfer Tool and setting dialog
cannot be executed at the same time.
e Terminate the Program Transfer Tool before
making a setting.
¢ Quit the setting dialog before using the Program
Transfer Tool.

1.2 SCREEN CONFIGURATION OF THE PROGRAM
TRANSFER TOOL

The screen of the Program Transfer Tool is shown below. The
screen is divided into an upper screen and lower screen. The upper
screen is a PC management screen, and the lower screen is a screen for
managing connection destinations such as a program memory and data

Server.
Menu bar Tool bar
@ A
FilefF) View(\] Communication(C)
|| [0 Mertiame_onz =] = Management
( PC Folder Trees: PC: My Computer C:AChcDatal0ozy screen of PC
E-Q‘ tdy Computer - By By b, Al =
PC Folder \_,j Floppy Digk. Drive [&:] | i i
Trees i VISTA_EN () Folder001 |  Folderin2 Dooo1 00002 00003 \Slider
CncData
-1, om
iz DR DR
- | Folder001 NG h h (i ¥
! i Folderd02 - 00004 00005 00008 00007 0oong — —File List of PC
Vertical - = 2 ad|E
sp||t bar achine List of Cannection Target: Program Memor}l\ o0z ManathDE Series 310 J/CNC_MEMAUSEN
E|--:J Machine List B Iy I
] 001, MenMame_ 001 | | e . .
=H EIEI2.[DM:::]ame_UE|2 Folderd0l  |Folderioz | 0oODY ooz 00003 File List _Of
5. CHC_MEM Connection
o I T S Target
. . B L MTB2 e he e ke e
Machine List of B L SYSTEM Doo04 Do00s 00006 Program 0001 Program_0002
Connection Bl USER
1. |, LIBR&RY N N
Target =B FaTH
. Folderd01 e = Management
[#- || Folderd02 Program_ 0003 Program_0004 screen of
#- |, PATH2 C "
~[E] 003 Meriame_D03 onnection
Target
12 Bités in Folder/ fJCNC_MEWUSEH\PATHwJonuna{Selected Use 28 Files. 35 KB Fre 3 Paga 1/2 Lwi
| | |
Horizontal split bar Current management status bar Status bar
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1.2.1 Menu and Toolbar

Menu bar
The menu bar includes commands for operating the Program Transfer
Tool screen

Toolbar
The toolbar displays buttons for frequently used commands.

Vertical/Horizontal Split bar
By dragging the mouse by a desired width after placing the mouse on
the split bar between the PC folder tree or Machine List of Connection
Target and the file list or between the PC management screen and
connection destination management screen, the width and height of
each divided screen can be adjusted.

Status bar
The status bar displays the total number of files of the currently
selected file list. If a command that consumes a longer time, such as
a command for folder switching or connection processing, is executed,
a message is displayed to indicate that command processing is in
progress.

Slider

The slider is used to switch the page of the PC file list.

When the number of files of the currently selected folder exceeds the
maximum number of files displayable one one page of the file list, the
rest is displayed on subsequent pages.

The maximum number of files displayable per page of the file list can
be set to an arbitrary value ranging from 100 to 5000 on the options
screen.

If all files can be displayed on one page, the slider is not displayed.
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1.2.2 Display of the Upper Screen (PC Information)

PC folder tree

The PC folder tree is located in the upper-left area of the Program

Transfer Tool screen.
(folder on Windows).

The PC folder tree displays "My computer"
An arbitrary file or folder on "My computer”

can be downloaded to or uploaded from a connection destination.

File list

The upper-right area of the Program Transfer Tool screen displays a
PC file list. The PC file list displays the icons of the files of the
folder currently selected in the PC folder tree.
Files are displayed using the icons corresponding to types as indicated
below according to the file names and extensions.

File name and extension Icon Type
File name with an extension specified for &
programs on the setting dialog (A file name HC Program
with no extension may be specified.)
[
File name for data other than programs (*1) DAT, Data
File names and extensions other than the above D Other

*]1 The table below indicates the file names for data other than

programs.

Tool offset

Custom macro

Workpiece

variable origin offset
Series 30i31i32i-A | 155 OFSTTXT | MACRO.TXT EXT WKZ.TXT
Series 0i-D -
Series 16i/18i/21i-A/B
Series 0i-B/C TOOLOFST.DAT |MACROVAR.DAT |WORK-G54.DAT
Series 20i-B

Power Mate i-D/H

TOOLOFST.DAT

MACROVAR.DAT

None

*  The file names above are for data of the first path. For data of a
second or subsequent path, the extension "P-path-number" is
used. However, for the tenth path, the extension is "P10".

Example:

Tool offset data of the second path: TOOLOFST.P-2
Tool offset data of the tenth path: TOOLOFST.P10

NOTE

The file name of data other than programs is the
same as given when bit 0 of parameter No. 138 is
set to 1 on the CNC and data is output to a
memory card without specifying a file name.

Current management status bar

The PC side current management status bar displays the path of the
folder currently selected in the PC folder tree.
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1.2.3

Display of the Lower Screen (Connection Destination
Information)

Machine List of Connection Target

File list

The lower-left area of the Program Transfer Tool screen displays a
Machine List of Connection Target. @ The Machine List of
Connection Target displays a Machine List.

The Machine List displays machines for which a communication
setting has already been made on the setting dialog.

When a machine is selected from the Machine List, communication is
performed with the machine and the list of programs at the connection
destination is read and displayed as a file list.

When a connection is made with the Series 30i/31i/32i or a data server,
a folder list is displayed in tree form.

The lower-right area of the Program Transfer Tool screen displays a
connection destination file list. A list of programs read by
performing communication with a machine is displayed.

Current management status bar

The connection destination current management status bar displays
information (machine number, machine name, path number, and so
forth) about the machine currently selected in the Machine List of
Connection Target. If the selected machine is not connected, the
machine name only is displayed.
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1.3 PC FILE LIST OPERATION

1.3.1 Changing the Display of the PC Side Current Management
Folder

The PC side current management folder is the current operation target
folder on the PC side. A list of files is displayed.

(1) Initially, when the Program Transfer Tool screen is started, the
PC folder tree displays a list of the drives under "My computer",
and the Machine List of Connection Target displays a Machine
List.

%@ Program Transfer Tool

File(F) View(Y) ToolT) Help(H)
I = xelos| [
PC Falder Trees: FC:
E@, by Computer
i!ﬁ Floppy Disk Drive (&)
e VISTA_EN[C)
cw 050D
e WK_IP[E:)
e WIK_EN[F)
i #P_IP G
-y ¥P_EN [H:)

Machine List of Connection Target: Program Memony:

El-E] Machine List
- E] 001, MenMame 001

- F] 002, MenMame 002

. __ L

(2) When the user clicks a folder in the PC folder tree, the folder is
selected as the PC side current management folder and the
contents of the folder are displayed in the PC file list.

%@ Program Transfer Tool
I File(F) View(Y) ToolT) Help(H)

PLC Folder Trees: : My Computer C:AChcD atah

E@‘ Iy Computer
15 Floppy Disk Drive (A7) i

SE VISTA E

, Folderooi
, Folder0i2

Machine Ligt of Connection Target: Frogram temary:

E-E] Machine List

E] 001 Mename_ 001
| 002 MenMame_002
£ 003 MeonMame_003

3 Displayed Files / 3 of All Files Page 141
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1.3.1.1

When the user clicks a machine in the Machine List of
Connection Target, the PC folder that is set for the machine and
is displayed at communication start time is selected in the PC
folder tree and the contents of the PC folder are displayed in the
PC file list.

File(F) View(Y) Communication(C) Tooll) Help(H)

{00 Mename_001 =] [ncDs| =%

PLC Folder Trees: PLC: My Computer C:AChcDatah0oty

E@, 4y Computer by by by B B
+-k Floppy Disk Drive (4] L

& VISTAEN (E) | oo o000z 00003 00004 00005
CncData

m
, o2
. Folder00
, FolderD02

Machine List of Connection T arget: Program Memory: | 001, MenMame_001 [Path Mo.:1] | Series 18i

El-[E] Machine List L L N I I
—I-[£] 001, MenName_001 ' ||

[DaTA] 00003 00004 00005 00006 00007

%] 002 MenName 002 2 ™ LY [N ™ [
00010 Selected Use 12 Files, 25080 Char. Free 988 Files, 106080 Char. Page 141

A connection destination device can also be selected from the list
box on the left side of the toolbar.

Changing the method of display

The method of display can be changed as indicated below by choosing
from the [Upper File List] menu on the [View] menu or choosing from
the corresponding buttons on the toolbar.

File(F) | View(V) | Tool(T) Help(H)

v Tool Bar(T)

PCFolde ¥ StatusBar(s) PL: My Computer C:\CncD atah 002

Upper File List(U) »| v Largelcon(G) D D D -
Lower File List{L) 3 List(L) U
- oo o000z 00003
Refresh(R) Details(D)
- Arrange Icons 3
: m..mlrnldmnm R o ’—b' ’—b' ’—b'
Command name on Button on the - .
. . File list display method
[Upper File List] toolbar
[Large Icons] o Large icon
—n
[List] a-a- Small icon

[Details] Detailed display of the
following:

File name, file type, size
(bytes), last modification

data and time
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1.3.1.2 Changing the order of display

By choosing [Upper File List] then [Arrange Icons] from the [View]
menu, the user can make a selection from Sort by Name, Sort by Type,
Sort by Size, and Sort by Date (last modification date and time).

%@ F_'rogram Transfer Tool
File(F) | View(V) | Tool(T) Help(H)

l_ v Tool Bar(T) |DS| E ] |
PCFolde ¥ StatusBar(s) [PC [MyComputer  |C:ACncDatah0o2:
E‘"%- Upper File List(U) »| v Largelcon(G) D D D -
-l 4
5. Lower File List(L 3 List(L: b
E‘E cuertie b st o001 0002 00003
Refresh(R) R
Arrange Icons »| ¥ Sort by Name(F) D
. Falder001 — — Sort by Type(T)
, Folder0i2 - I 00004 00005 i oooos -
Sort by Size(S)
Machine List of Connection T arget: | Program Memary: | Sort by Date(D)

- E] Machine List |

If [Details] is selected as the file list display format, a display order
selection can also be made by clicking [File Name], [Type], [Size], or
[Last Modification Date] at the top of the file list.

1.3.1.3 Updating the display

Press the [F5] function key or click the [Refresh] command on the
[View] menu.

The PC file list and connection destination file list are updated to the
latest information.

%@ Program Transfer Tool

|Fi|e(FJ View(V) | Tool(T) Help(H)

I v Tool Bar(T) |DS| E £ |5

PCFolde ¥ StatusBar(s) [Pc: [MyComputer  |C:ACnoDatah0024

=8 Upper File List(U) v B
g - i i L
Ek Lower File List(L) 3 s
al Folder001  Folder002 0000 oono2 00003
Refresh(R)

T T T . T (™
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1.3.2  Operating Files and Folders on the PC

This subsection describes the methods of operating files and folders
displayed in the PC file list. View, edit, copy, move, delete, rename,
and create (folders only) operations can be performed.

1.3.2.1 Viewing a file

A file on the PC can be viewed. A viewer for view operation can be
specified using the Options dialog box. For details, see Subsection
1.7.2, "View, Edit Tab". If no viewer is specified, the file viewer
built into the Program Transfer Tool is used.

The procedure is as follows:

(1) Click a file to be viewed in the PC file list.
(2) Perform a mouse operation or menu operation as described
below.
A) Mouse operation
Double-click a file to be viewed in the PC file list. The
viewer is started.
B) Menu operation
B-1) Click a file to be viewed in the PC file list.
B-2) Click the [View] command on the [File] menu or on
the menu displayed by right-clicking the selected file.
The viewer is displayed.

NOTE

1 [File Viewer] enables only one file to be viewed at a
time.

2 [File Viewer] is a text viewer, so that it cannot be
used to view a binary file.

3 The maximum size of a file displayable by [File
Viewer] is 32K bytes. If a file larger than 32K
bytes is viewed, the 32K-byte contents of the file
starting from the top of the file are displayed.

4 Only when [View] is selected from [Double click on
PC file list] in the [Options] dialog box, the viewer
can be started. For details, see Subsection 1.7.1,
"Listing Tab".
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1.3.2.2 Editing a file

A file on the PC can be edited. An editor for edit operation can be
specified using the Options dialog box. For details, see Subsection
1.7.2, "View, Edit Tab". If no editor is specified, the Notepad
available with the Windows OS is used.

The procedure is as follows:

(1) Click a file to be edited in the PC file list.
(2) Perform a mouse operation or menu operation as described
below.
A) Mouse operation
Double-click a file to be edited in the PC file list. The
editor is started.
B) Menu operation
B-1) Click a file to be edited in the PC file list.
B-2) Click the [Edit] command on the [File] menu or on the
menu displayed by right-clicking the selected file.
The editor is displayed.

NOTE
Only when [Edit] is selected from [Double click on
PC file list] in the [Options] dialog box, the editor
can be started. For details, see Subsection 1.7.1,
"Listing Tab".

1.3.2.3 Copying a file

The procedure for copying a file on the PC to another PC folder is
described below.

Copying a file by drag and drop
(1) Click a file to be copied in the PC file list.
To select multiple files, click each file while holding down the
[Ctrl] key.
(2) Drag a selected file to a desired folder in the PC folder tree or the
PC file list then drop the file while holding down the [Ctrl] key.
(3) The [Copy File] dialog box is displayed.
Check the copy data then click the <Copy> button.

Copy File

From: c:WMeD atah002h

000
0000z
00003

_ e | Ceedd
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Copying a file by menu or keyboard operation

(1) Click a file to be copied in the PC file list.

To select multiple files, click each file while holding down the
[Ctr]] key.

(2) Click the [Copy] command on the [File] menu or on the menu
displayed by right-clicking a selected file, or press the [Ctrl+C]
key.

(3) Select a copy destination from the folders in the PC folder tree or
the PC file list then click the copy destination.

(4) Click the [Paste] command on the [File] menu or on the menu
displayed by right-clicking the PC file list, or press the [Ctrl+V]
key.

(5) The [Copy File] dialog box is displayed.

Check the copy data then click the <Copy> button.

(6) If a file is copied by a menu or keyboard operation, the copy
source file is preserved. So, the file can be copied to another
folder in succession.

Pressing the [ESC] key clears the copy source file information.

NOTE
If a copy source and a copy destination are the
same folder, the file cannot be copied.

1.3.2.4 Moving a file

The procedure for moving a file on the PC to another PC folder is
described below.

Moving a file by drag and drop

(1) Select a file to be moved in the PC file list.
To select multiple files, click each file while holding down the
[Ctrl] key.

(2) Drag a selected file to a desired folder in the PC folder tree or the
PC file list then drop the file without pressing any key.

(3) The [Move File] dialog box is displayed.
Check the move data then click the <Move> button.

From: c:WMeD atah002h

00004
00005
00008

Mwe[M] —
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Moving a file by menu or keyboard operation

(1) Click a file to be moved in the PC file list.

To select multiple files, click each file while holding down the
[Ctrl] key.

(2) Click the [Cut] command on the [File] menu or on the menu
displayed by right-clicking a selected file, or press the [Ctrl+ X]
key

(3) Select a copy destination from the folders in the PC folder tree or
the PC file list then click the copy destination.

(4) Click the [Paste] command on the [File] menu or on the menu
displayed by right-clicking the PC file list, or press the [Ctrl+V]
key

(5) The [Move File] dialog box is displayed.

Check the move data then click the <Move> button.

NOTE
If a move source and a move destination are the
same folder, the file cannot be moved.
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1.3.2.5 Deleting a file or folder

The procedure for deleting a file or folder on the PC is described
below.

(1)

2)

3)

Click a file or folder (herein after simply referred to as a "file") to

be deleted in the PC file list.

To select multiple files to be deleted, click each file while

holding down the [Ctrl] key.

The [Delete File] dialog box is displayed when one of the

following operations is performed:

e  Press the [Delete] key.

e  Click the [Delete] command on the [File] menu.

e  C(Click the [Delete] command on the menu displayed by
right-clicking a selected file.

Clicking the <Delete> button deletes a selected file. To cancel

the deletion of a selected file, click <Cancel>.

Delete File

Deleting File: C:\NeD atab002

ooaF
0oo0og
00003

Delete(D] - CancelDl

NOTE
1 When a folder is deleted, all files and folders

2 All deleted files and folders are completely erased

contained in the folder are deleted.

from the personal computer and none of them are
left in the recycle bin of Windows. Be very careful
when deleting a folder.
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1.3.2.6 Renaming a file or folder

The procedure for renaming a file or folder is described below.

(1)
2)

)

Click a file or folder to be renamed in the PC file list.

Click the [Rename] command on the [File] menu or on the menu
displayed by right-clicking the selected file or folder. The
[Rename File] dialog box is displayed.

Enter a new name in the [New Name] text box then click the
<Change> button. Until a name is entered in the text box, the

<Change> button is disabled.

Original Marme: C:\MNeDatah 002y
|o0om

Mew Marne:
|NewFile

Change[0] CancellC)

1.3.2.7 Creating a new folder

The procedure for creating a new folder is described below.

(1)

2)

)

Click a folder under which a new folder is to be created in the
"My computer”" (PC folder tree) then specify the folder as the PC
side current management folder.

Click the [Create Folder] command on the [File] menu or on the
menu displayed by right-clicking the file list. The [Create
Folder] dialog box is displayed. However, when using the
right-click menu, right-click the mouse button at a file list
position where no files and folders are placed. If the user
right-clicks the mouse button on a file or folder, the [Create
Folder] command is not enabled.

Enter the name of a folder to be created in the [New Name] text
box then click the <Create> button. Until a name is entered in
the [New Name] text box, the <Create> button is disabled.

Create Folder,

Mew Mame; C:5MH cDatab002%

|MevFolder

Create(D] ‘ Cancel[C] ‘
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1.4 FILE TRANSFER TO AND FROM THE PROGRAM
MEMORY

Programs and folders in the program memory can be transferred.

1.4.1 Display of a List of Programs in the Program Memory

Select a machine from the Machine List of Connection Target.
When a machine is selected, communication starts according to the
method specified on the setting dialog.

NOTE

If communication with the data server is started,

switch the connection to the program memory by

one of the methods indicated below. When the

connection is switched, communication with the

program memory of the selected machine is

started.

e Click the [NC] button on the toolbar.

¢ Point to the [Change Connect] command on the
[Communication] menu to display a list of
connection destinations. Click [Program
Memory].

The PC file list displays the contents of the PC folder that is set with
the machine for display at communication start time. Refer to (2),
"Selecting PC folder to be displayed when communication is started"
in Section 1.5 "DISPLAY", of Part III, "Setting".
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Select McnName_002 |:l‘> Display the file list in the folder allocated

%Iﬂ Program Trangfer Tool

File(F) View(V] | Communication(C) Teol(T} Help(H)
|002. MenName_00p

PC Folder Trees:

for McnName_002.

:A\ChcDatahooz'

E@ kdy Computgr

k4 Floppy Disk Dirive (&)
WISTA_EM [T |
) Chcdata

;P

Folder001

) Folder001
|, Falder0iz =

Folder002

0nant

00002

Machine List of Conpiection Target:

Program Memony: | 002, MonMame 002 | Seness 310 #4C

Bl ] Machine Li
7] 001 1¥Name_ 001 ;
Q002 MenMame_002

& | Folderd02
| PATH2

|

Folderd01  Folder002 0oaot
| DAETE]
| CNC_MEM
#- | MTB1 Y
L MTBZ HC HC G
L SYSTEM aninz 00004 00008
- | USER
- | LIBRARY

[ [ L=
i Foldei00T Lk Lk LE

Program_ 0007 Program_0002 Program 0003 Program_ 0004

12 Files in Folder/ //CWC_MEMUSER/PATHT/00003 Selected Usi | Page 14

The Machine List of Connection Target and connection destination
file list display the following data according to a connected CNC:
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<For the Series 30i/31i/32i>

Under the connected machine name in the Machine List of Connection
Target, the folders of the program memory are displayed in tree form.
The tree also displays the [DATA] file used for transfer of data other
than programs.
The connection destination file list displays a list of the folders set in
the foreground of the first path of the CNC.

Select McnName_002

File(B) View(\)

F:B Program Transfer Tool Elﬂg?

Communication(C)] Tool(T) Help(_]

PC Falder Trees:

|002. MerMarme_002

PLC: Fy Computer C:AChcDatah 002

E@ ty Computer - B N
,;j Floppy Dk Dirive: 4] ‘_‘ { |
B VISTAEN (C) | Foldeitt  Foldeiiz 00001 nnan?

. CncOata
ol
e N
. Falder001 h HE e 3
. Folder002 - nooo3 oonn4 00005 onoog - =

t achine List of Connkction Target: Program Memory: | 002, MonMame_002 | Series 310 A/

=5 _J Maching Lizt
: o, | i . .
= K002 Merhlame 00 Fodbd0l  Foldei002 00001 2

—DETA]
4. CHC_MEM
75 T P [ P .
| SYSTEM 0oon3 oonn4 0ooos 00006
. USER
-1 LBR&RY . N . N
| Folderdat biC e L hic
& FolderOd Progrsgy_0001 Program D002 Program 0003 Progrsf 0004
B L PAT
----- E] 003, Mo ame_003
12 Files in Folder/ //CNC_MEMAJSERPATH1/D0003 Selected Usi| Page 141
Folder tree in program memory Program list in program memory of
of McnName_002 is displayed McnName_002 is displayed
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<For other than the Series 30i/31i/32i>

If only one path is set with the connection destination device on the
setting dialog, the [DATA] folder used for transfer of data other than
programs is displayed in tree form under the connected machine name
in the Machine List of Connection Target. If two or more paths are
set, the [DATA] folder and path information are displayed in tree
form.

The connection destination file list displays a list of the files in the
memory of the first path of the CNC.

Select McnName_001
( %@ Program Transfer Tool E@gj

File(F} View(d] [Communication(C] TeoolI} Help(H)

I |001. MenName_001 | ]_J oy &2

PC Folder Trees: C: by Computer CAChcDatas 001y

E@ tdy Computer| - Iy By
L‘_:_j Floppy Dk Drive [ |_ . .
i VISTA_EN T ooont 00002 00003 00004

, Chclata
W 001
L2 5
#- | FolderD01 MG
- |, Folder002 b ooons
Machine Ligt of Conngction Target: Program Memorny; | 001, MenMame_001 [Fath Mo 1) | Senes 181
- Oyali0= 00004 DDDDE DDD
E ™ I T .
ﬂ DDS. aname 003 h h h h
ooooF 0oaas oooo9 oaoio
[ L [ N
o085 oonao oFoo7 0apa

00010 Selected Use 12 Files, 25080 Char. Free B3E Files, 106080 () Page 1/1
Path information of Program list in program memory of

McnName_001 is displayed McnName_001 is displayed

Each time the user clicks the [File List] command on the
[Communication] menu, the list of files in the program memory is
updated to the latest information.
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1.4.1.1 Changing the method of display

The method of display can be changed as indicated below by choosing
from the [Lower File List] menu on the [View] menu or choosing

from the corresponding buttons on the toolbar.

File(F) Communication(C) Tool(T) Help(H)

|[002 Me v Tool Bar(T) ros| o0 ([ |
FCFoldd ¥  Status Bar() PC: My Computer C:\CneDatabi0z,
B8N UpperFile Listtw) v 1 ‘ ‘ -
=g Lower File List(L) v [ ]| Large JcontG) NG HC
OWEr rFlle LI% arge lcon
=g o Qo001 00002
Refresh(R) List(L)
002) Details(D) b b
- |, FoldeiD1 Arrange Icons 3
‘e | FolderD02 Ly 0000s ooooE -
Command name on File list displa
. . Button on the toolbar play
[Lower File List] method
[Large Icon] o Large icon
[List] Small icon
Ests
[Details] Display dependent on
the communication
destination device

When [Details] is selected for display, the following data is displayed
according to the CNC at the communication destination:
<Program memory of the Series 30i/31i/32:1>
File name, file/folder type, comments in a program, size, last
modification date and time
<Program memory of other than the Series 30i/31i/32i>
O number, comments in a program, size, last modification date
and time

1.4.1.2 Changing the order of display

By choosing [Lower File List] then [Arrange Icons] from the [View]
menu, the user can make a selection from the following.
<Program memory of the Series 30i/31i/32i>
Sort by Name, Sort by Type, Sort by Comment, Sort by Size,
Sort by Date (last modification date and time)
<Program memory of other than the Series 30i/31i/32i.>
Sort by O Number, Sort by Comment, Sort by Size, Sort by Date
(last modification date and time)

If [Details] is selected as the file list display format, a display order
selection can also be made by clicking the following at the top of the
file list.
<Program memory of the Series 30i/31i/32i>
[File Name], [Type], [Comment], [Size], [Last Modification
Date]
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<Program memory of other than the Series 30i/317/32i>
[O Number], [Comment], [Size], [Last Modification Date]

1.4.1.3 Changing the path of the CNC under communication

If two or more paths are set with a connection destination device other
than the Series 30i /317 /32i on the setting dialog, the communication
target path can be changed.

(1) Paths are displayed under a machine name in the Machine List of
Connection Target. Click a desired path. Alternatively, point
to the [Change Path] command on the [Communication] menu.
A list of paths is displayed. Click a desired path.

%@ Program Transfer Toal QE
File(F} View(V) | Communication(C) | Tool(T) Help(H)

001. MenMame_00 Download(L)...

FLC Falder Trees: Upload(U)... - [C\CncData\odty

S My Computs pjee(p).. b B
-4 Floppy [ b hc

Rename(N)...
00003 Qo004

Create Folder(F)...

File List(L)

: Change Path(F) "V Pathl O\
Etlof{Fon Change Connect(Q0) N RathZ / 0SS 18

tachine Lis L, N
-E End Communication(X) "

e a0 00005 00005

R S M Mo [ [

(2) Communication is switched to the selected path, and the display

of the connection destination file list switches to the information
of the path selected for communication.
The connection destination current management status bar
displays the currently selected path. The Machine List of
Connection Target displays the currently selected path in reverse
video.

EIE Program Transfer Tool Eab

File(E) View(\) Communication(C) Tool() Help(H)

001, MenMame_om | IEJ 57 =

PC Folder Trees: PL: fy Computer CAChcDatah001

E@‘ My Computer - I Iy B B
[ Floppy Disk Drive [8:) |:|
VISTA_EN () —I| ooom o000z 00003 00004
ChcData
.
ooz 5
- FolderDm WG
- |, Folder0oz 7 00005

achine List of Connection T arget: Pragram Memory: | 001. MenMame 001 [Path No.:2] ) Series 18i
E+E] Machine List Ly L
- [F] 001, MenMame_001

- [DATA] 0002 oo

ame

i T — I
Bl 003 MenMame_003

selected path
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1.4.2 File Transfer to and from the Program Memory

1.4.2.1

Uploading from the program memory to the PC

(1) Click a file to be uploaded in the connection destination file list.
To select multiple files to be uploaded, click each file while
holding down the [Ctrl] key. With the Series 30i/31i/32i, a

folder can also be selected.

(2) Perform one of the following operations:
A) Drag and drop a file selected in the connection destination

file list onto the PC file list.

When the selected file is

dropped on a file or blank area of the PC file list, the file is

uploaded to the folder displayed in the PC file list.

When

the file is dropped onto the folder in the PC file list, the file

can be uploaded to the folder.

B) Drag and drop a file selected in the connection destination

file list onto the PC folder tree.

C) Click the [Upload] command on the [Communication] menu
or on the menu displayed by right-clicking a selected file.
If a file is selected in the PC file list, the selected file is
uploaded to the folder displayed in the PC file list.
If a folder is selected in the PC file list, the selected file is

uploaded to the folder.

%@ Program Transfer Tool

........ Upload(U)...

Ly Compute Delete(D]...

C - L?j Floppy [
EA_{‘ WISTA, | Rename(M)...
- 1. Cnc
: Create Folder(F)...
B ..

File List(L)

Machine List of Cor

E|_FJ Machine Lis
=B 001 Me End Cemmunication(X)

Shange Path(P)

Change Connect(Q)

File(F)  View(V) Tool(T) Help(H)

I 002, MenM ame_00; Download(L)...

A
[E= e
o ,
mputerd | CACReDatah002,
3 s, i -~
3
Fodedz  DOOC: 00002
Y L L
.
00004 005 ooooe -
DU2.Maname_@S«aéel—§l¢\ 0

El:J DDE MCnNCIIIIIS_UU
e || [DATA]
Bl | CMC_MEM
7 | MTE1
| MTEZ
| SYSTEM
.|, USER
=~ | LIBRARY
© Bl FolderdOl
¢ E- | Folderl2

m

-

Folder002

Ly Iy

00004 00005 00006

L L Y Y

Program_0001 Program_0002 Program_0003 Program_0004

12 Files in Folder/ //CMC_MEM/USER/PATH1/00003 Selected Use 29 Fil | Page 1/1
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NOTE
When the [Upload] menu is used to upload a file,
the file is uploaded to a folder selected, if any, in
the PC file list. Before operating the menu, check
for a file or folder selected in the PC file list.

(3) The [Upload Program] dialog box is displayed according to the
contents to be uploaded.

When only files are uploaded, the dialog box shown below is
displayed.

<When only files are uploaded>

Upload File: //CNC_MEM/USER/PATHY/

000
0aooz

UploadiU) . CancellC)

If a file with the same name exists on the PC, a message for
checking whether the existing file may be overwritten is output
as shown below.

f"’ This folder already containg a same name file.
Would you like to replace the existing file with the new fle?

Exizting file;
C:ACncData\002400001
Size(BYTE): 584
Modified on: 3417/2008 2:44:47 AM
Mew File:

HMCHC_MEMAUSER/PATHT /00001
Size(KB]: 1
Modified on: 2008/03/18 14:24:12

Yes(r) ‘es to AlA) d CancellD)

When only folders are uploaded or files and folders are uploaded,
the dialog box shown below is displayed. Select an upload
option.
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4)

<When folders are uploaded>

IIpload File: //CHC_MEMAISER/FATHT/

Folder00i /
Folder00z/
o007

Option for uploading

W Can not ovensrite.
[v Cancel the process when it failed.
v Upload under the subfolders too.

Up|,:,a,:|[u]

CancellC)

The upload options are described below.

Can not overwrite

Does not write over a file with the same
name if existing at the upload destination.

Cancel the process  Stops processing when a file or folder

when it failed.

Upload under the
subfolders too.

upload operation fails. No additional
files and folders are uploaded.

Upload all subfolders contained in a
selected folder and all files under each of
those subfolders.

Click the <Upload> button.
If folders are included, the following result dialog box is
displayed each time a selected folder is uploaded:

Result uploaded folders

Selected folder:

ACMC_MEM/USER/PATHT AFolder002¢

File M ame Type Process Fesult Error Message
o/ Folder Skip Success

] 0100 Program Osenrite Success

[ SubFoldert / Folder Mew Success

] SubFolder A0 0005 Frogram Hew Success

] SubFolder /01007 Frogram Hew Success

< *
Success: | 1]
Failure: | |
Skip: | 1]

Folder

e  Selected folder: Indicates the path of a folder to be
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e  Process: Indicates upload processing.
Process Meaning
New When a file is uploaded

- There is no existing file with the same name on
the PC, so that the file is uploaded.

When a folder is uploaded

- There is no existing folder with the same name on
the PC, so that a folder is newly created.

Overwrite | When a file is uploaded

- There is an existing file with the same name on
the PC, so that the file is uploaded and written
over the existing file.

Skip When a file is uploaded

- There is an existing file with the same name on
the PC, so that the file is not uploaded.

When a folder is uploaded

- There is an existing folder with the same name on
the PC, so that no folder is created. The files
and subfolders under the target folder are
uploaded.

e  Result: Indicates ~ whether  uploading  was
successful or not.

e  Error Message: An error message is displayed when
uploading has failed.

(5) A selected file is uploaded to the PC and the PC file list is
updated to the latest information accordingly.

NOTE

1 With a CNC supporting file name management
such as the Series 30i/31i/32i, a distinction can be
made between the uppercase and lowercase
letters. With the Windows OS, however, such a
distinction is impossible.
With a CNC, therefore, a file named AAA and a file
named a